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Introduction
The MBX Driver Suite for Windows NT/9x is a collection of several well integrated products that provide
connectivity for Modicon Modbus Plus and Ethernet networks in distributed environments. These
products provide complete device driver support for 32-bit Windows (Win32) as well as 16-bit DOS and
Windows (Win16) applications.

The MBX Driver Suite includes the following software products:

• MBX Driver: Device driver for Modbus Plus host interface adapters.

• Ethernet MBX Driver: Driver for Modbus Plus emulation over TCP/IP (Windows NT only).

• Remote MBX Driver: Provides remote node access to Modbus Plus and Ethernet networks.

• Virtual MBX Driver: Enables16-bit legacy software to run in 32-bit Windows operating systems.

In the past, the MBX Driver Suite components were distributed as separate products. Combining these
products on a single CD provides the following benefits for end users:

• All products are at the same revision level. When upgrading an older version installation of just one
product, the new integrated installer allows upgrading of all installed MBX family products as well. This
ensures that all installed products will properly interoperate with each other.

• Both Windows NT and Windows 9x platforms are supported by a single CD. The MBX Driver
Suite automatically detects the operating system and installs all selected components.

• A single part number works for all driver products. Users will not be required to order multiple
components with multiple part numbers. Furthermore, users will now have all driver products
available when needed. At first, your application may require only one driver product to operate. But if
the job requirements change and other driver products need to be installed, they will be available on
the CD.

• To provide support for legacy installations, floppy disk images from previous versions (v2.11 and
v4.01) of all MBX driver products have been included on the MBX Driver Suite CD.

• Several subscription programs can now be purchased to ensure prompt software updates to the
latest revision level as soon as it is released. With a subscription license, users will receive automatic
updates to the MBX Driver Suite. This is especially important when a new version of an operating
system is released. The subscription updates will also reflect all new enhancements, such as support
for new host interface adapter cards. For details of subscription programs, contact your Schneider
Automation, Inc. Modicon brand distributor or visit Schneider Automation’s website at
www.modicon.com.

What Should I Do Next?
The MBX Driver Suite consists of several discrete but well integrated driver products. Collectively, these
components provide connectivity for Modicon Modbus Plus and Ethernet networks in distributed
environments. For more information about these products, refer to the MBX Architecture and Companion
Products section.

For product installation or upgrading instructions, refer to the Installation section. If you are not sure which
component(s) to install, read the Which Driver Product Should I Install? subsection. If you prefer to use
older versions of the driver products, read the Legacy Installations subsection.

In case of installation problems, read the Troubleshooting section for problem solving hints.

After a successful installation, refer to each MBX product help file for detailed information.

http://www.modicon.com/
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The content of this document is also provided in the PDF file format. PDF files can be viewed using the
Adobe Acrobat Reader program. The printer-friendly PDF files can be used to print the complete
document with good quality output. A copy of Adobe Acrobat Reader is included on the product CD and
can be installed from there.
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MBX Architecture and Companion Products

MBX Family Components
The MBX architecture is the foundation of the MBX Driver Suite. Designed for Windows NT/9x with
support for legacy applications, the well integrated components of the suite provide connectivity for
Modicon Modbus, Modbus Plus, and Ethernet networks in distributed environments.

Figure 1 – The MBX architecture presents a consistent framework to address different connectivity needs.

Software products available in the MBX family are:

• MBX Driver: Device driver for Modbus Plus host interface adapters (Windows NT version includes the
MBX Remote Server for remote connectivity).

• Ethernet MBX Driver: Driver for Modbus Plus emulation over TCP/IP (Windows NT version includes
the MBX Remote Server for remote connectivity).

• Remote MBX Driver: Provides remote node access to Modicon Modbus, Modbus Plus, and Ethernet
networks.

• Virtual MBX Driver: Enables 16-bit legacy software to run in 32-bit Windows operating systems.
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• MBX Bridge: Bridges Modicon networks by routing messages between MBX devices.

• MBX SDK: Software development kit for MBXAPI and NETLIB compliant development (Schneider
Automation part number SW-LNET-SDK).

MBX Driver
The 32-bit MBX Driver provides connectivity between Modicon ModConnect host interface adapters and
32-bit applications running under Windows NT/9x.

The kernel mode device driver of the MBX Driver is the highest performance Modbus Plus driver in the
industry. The driver can operate in either interrupt or polled mode and supports all current Modicon
ModConnect host interface adapters for ISA, EISA, MCA, and PC Card (PCMCIA) buses. Multiple
interface cards can be installed at the same time, limited only by the number of available slots. Full
implementation of all Modbus Plus features provides support for Data Master/Slave, Program
Master/Slave, Global Data, and Peer Cop. The high-performance native API (MBXAPI) of the MBX Driver
takes advantage of the event-driven, multitasking, multithreaded features of 32-bit operating systems.
The driver also includes the MBX Remote Server for remote access by the Remote MBX Driver.

The MBX Driver is compatible with all other MBX family products.

Ethernet MBX Driver
The 32-bit Ethernet MBX Driver provides connectivity between Modicon Ethernet compatible processors
and Windows NT/9x based 32-bit applications using either Modicon NETLIB or Cyberlogic’s high-
performance MBXAPI interface specification. It is compatible with all Ethernet network adapters
supported by the operating system and provides Data Master/Slave and Program Master/Slave features
of Modbus Plus on Ethernet networks. The driver also includes the MBX Remote Server for remote
access by the Remote MBX Driver.

The Ethernet MBX Driver is compatible with all other MBX family products.

Remote MBX Driver
The Remote MBX Driver provides remote connectivity for applications running on client nodes requiring
access to Modbus Plus networks from remote locations via standard LANs.

The remote client running the Remote MBX Driver must be a Windows NT/9x node. By accessing the
Modbus Plus and Ethernet networks connected to server nodes on a network, the Remote MBX Driver
provides complete MBX Driver functionality to the client node, including support for Data Master/Slave,
Program Master/Slave, Global Data, and Peer Cop. A host interface adapter (such as Modicon SA85
card) is not required on the client node. Remote MBX Driver nodes can communicate with multiple remote
servers and all Windows NT-compatible computer networks are supported.

The Remote MBX Driver is compatible with all other MBX family products.

Virtual MBX Driver
The Virtual MBX Driver enables 16-bit NETLIB/NetBIOS-compatible applications (e.g. ModSoft or
Concept) to run concurrently with 32-bit applications in the same computer. It allows multiple 16-bit
applications (as well as multiple instances of a single 16-bit application) to run under the 32-bit Windows
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operating systems.

The Virtual MBX Driver requires the MBX Driver, the Remote MBX Driver, or the Ethernet MBX Driver to
operate.

MBX Bridge
Note: Schneider Automation, Inc. does not distribute the MBX Bridge. It is only available from and

supported by Cyberlogic Technologies, Inc. as a third party product. You can find more
information about this product from the Schneider Alliances website at www.modicon.com or
Cyberlogic’s website at www.cyberlogictech.com .

 The MBX Bridge seamlessly routes messages between MBX compatible devices. Specifically, the MBX
Bridge can route messages in Ethernet-to-Modbus Plus or Modbus Plus-to-Ethernet networks. Depending
on the user’s needs, it may require one or more of the following products to operate:

• MBX Driver

• Remote MBX Driver

• Ethernet MBX Driver

Blending MBX Supported Networks: Ethernet MBX and Legacy Installations
Providing support for all Modicon networks under the MBX architecture exposes consistent, identical
programming interfaces (the MBXAPI and the industry-standard Modicon NETLIB) for applications. This
ensures that practically all of the existing Modbus Plus compatible software programs can operate over all
Modicon supported networks with no code modifications. A product operating with one of the MBX driver
products (e.g. MBX Driver) is ensured to operate with the rest of the MBX driver products as well.

Migration of existing installations to new hardware products does not require the user to discard working,
proven software solutions. As depicted in the following diagram, a user can now mix Ethernet based and
Modbus Plus based hardware products in existing installations without losing existing software, network,
and integration investment.

http://www.modicon.com/
http://www.cyberlogictech.com/
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Figure 2 - MBX enabled system deployment: New hardware solutions will blend into existing installations
without software or network modifications.
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Installation

Which Driver Product Should I Install?
The MBX Driver Suite provides complete device driver support for 32-bit Windows (Win32) as well as 16-
bit DOS and Windows (Win16) applications. Since the suite is a collection of products, before installation,
you should determine which products will support your applications.

First, determine if your application is a 32-bit (Win32) or a 16-bit (DOS & Win16) application. If you are
unsure, refer to your product’s documentation or contact the software manufacturer.

Running 32-Bit Software
If you determine that your application requires 32-bit support, you should install one or more of the
following driver products:

• MBX Driver

• Ethernet MBX Driver

• Remote MBX Driver

For more information on these products, refer to the MBX Architecture and Companion Products section.

Running 16-Bit Software
If your application is a 16-bit DOS/Windows application (which you wish to run under 32-bit Windows
platforms), you must install the Virtual MBX Driver and at least one of the driver products mentioned
above in Running 32-bit Software.

The Virtual MBX Driver allows all 16-bit NETLIB/NetBIOS-compatible applications (e.g. ModSoft or
Concept) to run concurrently with all 32-bit applications in the same computer. For more information on
this product, refer to the MBX Architecture and Companion Products section.

Installation Manager
The MBX Driver Suite uses the Installation Manager for controlling the installation/upgrading process of
the selected MBX driver products.

How to start the Installation Manager?
To start the Installation Manager, use one of the following procedures:

Auto-run

Insert the MBX Driver Suite CD into the CD drive and let the auto-run start the Installation Manager.

Manual start

Run the Setup.exe file found in the MBX Driver Suite CD root directory. Click the Start button and select
Run… from the menu. In the dialog box, enter:

{CD_drive_letter}:\Setup.exe
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Alternatively, you can double click the Setup.exe file from the Windows Explorer.

Note: For systems that do not have a CD drive, you can use a network CD drive to install the MBX
Driver Suite.

Once the Installation Manager starts, you should see the following screen:

The three tabs, Install, Product Info, and Support control different aspects of the installation process.

Install Tab
This is the main screen from which you install or upgrade the MBX Driver Suite. The Installation
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Manager detects previous installations of all MBX driver products included in the suite. The Version
Found on System column shows the versions of products already installed on the system. If the version
is prior to version 4.20, an Uninstall checkbox will automatically be selected.

Note: Even if only one Install checkbox is selected, the Installation Manager will uninstall all MBX
driver products with versions prior to 4.20.

Once you make your selections, click the Go! button. If you want to cancel the installation, click the Exit
button.
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Product Info Tab
This screen allows you to view information related to each MBX driver product included in the MBX Driver
Suite. You may use this information to decide which product to install. For future reference, the Release
Notes, Help Files, and PDF Files will be available after the product installation.
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Support Tab
This screen provides you with Technical Support information. Before you contact Technical Support,
make sure to read the Troubleshooting section in the product’s help file.
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First Time Installation
The Installation Manager detects previous installations of all MBX driver products included in the suite. If
this is the first installation of these products, the Version Found on System column on the Install tab
screen will show not found for all products.
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To install the MBX driver products of your choice, select the appropriate checkboxes in the Install
column. Once you make your selections, click the Go! button. If you want to cancel the installation, click
the Exit button.
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Upgrading the MBX Drivers
The Installation Manager detects previous installations of all MBX driver products included in the suite.
The Version Found on System column on the Install tab screen shows the versions of products already
installed on the system. If the version is prior to version 4.20, an Uninstall checkbox will be automatically
selected.
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To upgrade all installed products, select the appropriate checkboxes in the Install column.

Note: Even if only one Install checkbox is selected, the Installation Manager will uninstall all MBX
driver products with version prior to 4.20.

When upgrading from any 4.xx version (e.g. 4.01), the Installation Manager will also upgrade your
current driver configuration. As a result, in most cases, no configuration will be required after the upgrade
is completed. However, for versions prior to 4.00 (e.g. 2.11), all configuration information will be removed.
For that reason, make sure that you have a good record of your configuration information of all of
these installations. Once the MBX Driver Suite products are upgraded, you will have to recreate all of
your configurations.

After making your selections in the Install column, click the Go! button to start the upgrade process.
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Typical Driver Installation
The following steps show a typical MBX Driver Suite installation session. Use them only as a guideline.
Depending on your selections, your installation may vary from the one shown here. As a guide through
the installation process, always read the instructions on the screen.

In the example below, we will upgrade the MBX Driver version 4.01.

1. Insert the MBX Driver Suite CD into the CD drive. The auto-run will start the Installation Manager,
and you should see the following screen:
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2. Select the  MBX Driver in the Install column and click GO! to begin the setup process.
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When upgrading from any 4.xx version (e.g. 4.01), the Installation Manager will upgrade your
current driver configuration as well. As a result, in most cases, no configuration will be required after
the upgrade is completed. However, for versions prior to 4.00 (e.g. 2.11), all configuration
information will be removed. For that reason, make sure that you have a good record of your
configuration information of all of these installations. Once the MBX Driver Suite products are
upgraded, you will have to recreate all of your configurations.

3. Click Yes to start the uninstall phase.
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4. Click Yes to start the uninstallation of the MBX Driver version 4.01.

During the uninstall phase you may be presented with questions about removing shared files.
Because these files are only used by the MBX products, they can be safely removed during
uninstallation.

5. Click Yes To All.

6. Click Yes to continue.

7. Click OK to continue.
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This ends the uninstall phase.

8. Click Next to continue.

9. Click OK to continue.
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Please read the following Software License Agreement. You must agree to the terms of this
agreement and click Yes to continue the installation.

10. Click Yes to continue.

11. Enter your name and your company name and click Next to continue.
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You can use the Browse button to select the destination directory for your installation. However, we
recommend using the default directory.

12. Click Next to continue.

You may create a new name for the destination folder. However, we recommend using the default
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folder name.

13. Click Next to continue.

Before the MBX Driver can be used, it must be configured. This is done through the MBX Driver
Configuration editor. The setup program can automatically start this editor for you.

14. Make sure that the Launch the MBX Driver Configuration Editor checkbox is selected and click
Finish to continue.
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Click the Help button to get more information on using the MBX Driver Configuration editor.

15. Configure the MBX Driver. You can get help on the driver configuration by clicking the Help button
found on the dialog box. Click Close when done.
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Legacy Installations 
To support legacy installations, the MBX Driver Suite CD contains the floppy disk images of versions 2.xx
and 4.0x of all MBX Driver Suite components. You can find these images in the directory tree starting
from the <CD Drive Letter>\Legacy directory.

Note: MBX driver products prior to version 4.20 can only be installed from a floppy disk (see
Installation Procedure subsection below). Direct installation from a CD will fail.

Disk Image Locations

Version 2.xx for Windows 9x

( found under \Legacy\v2xx\Win9x )

• LNETLIB (Local NETLIB Library, v2.10)

• RNETLIB (Remote NETLIB Library, v2.10)

• VDD (Virtual Device Driver for NETLIB/NetBIOS, 2.10)

Version 2.xx for Windows NT

( found under \Legacy\v2xx\WinNT )

• LNETLIB (Local NETLIB Library, v2.11)

• RNETLIB (Remote NETLIB Library, v2.00)

• VDD (Virtual Device Driver for NETLIB/NetBIOS, 2.00)

Version 4.0x for Windows 9x

( found under \Legacy\v40x\Win9x )

• LMBX (MBX Driver, v4.01)

• RMBX (Remote MBX Driver, v4.00)

• VMBX (Virtual MBX Driver, v4.00)

Version 4.0x for Windows NT

( found under \Legacy\v40x\WinNT )

• LMBX (MBX Driver, v4.01)

• RMBX (Remote MBX Driver, v4.00)

• VMBX (Virtual MBX Driver, v4.00)

Installation Procedure
1. Locate the selected product directory in the \Legacy directory tree on the MBX Driver Suite CD.

2. Make sure that your Windows Explorer is set up to view all files.
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a) In Windows Explorer, pull down the View menu and select Folder Options…
b) Select the View tab and uncheck Hide file extensions for known file types.

c) Check the Show all files box located under Hidden files.

d) Press OK to finish.

e) After the installation disk is created, you may return to the View tab and Restore Defaults.

3. Copy all files and subdirectories in the product directory to a 1.44 MB, 3.5” floppy disk.

4. Select all files on the floppy disk and disable the Read Only file attribute (in Windows Explorer go to
the File menu, select Properties and uncheck the Read Only check box).

5. Uninstall all MBX driver products with versions higher than the version being installed.

6. Make sure the floppy disk is not write-protected. To start installation, run the installer program located
in the floppy disk root directory. For Windows NT products, version 2.xx, run the install.bat file. For
all other products, run the setup.exe program.

7. Follow the on-screen instructions to complete the installation.



MBX Driver Suite Version 4.20 for Windows NT/9x

Cyberlogic Technologies, Inc. Page 29

Troubleshooting

Frequently Asked Questions

Helpful Hints

When upgrading an older version of an MBX driver product, the Installation Manager will first uninstall
the old version of the product. If a file that has to be deleted during the uninstall phase is being used by
some program, the uninstaller will not be able to delete this file. To remedy the problem, the uninstaller
will force the system to reboot. To avoid system reboots, exit all applications using MBX driver products
before upgrading to the new version. This includes stopping all MBX drivers and remote servers.

Frequently Asked Questions

I do not have a CD-ROM drive on my notebook. How can I install the MBX Driver Suite?

You have two options: 1) you can use an external CD-ROM drive (some models connect through the
parallel port) 2) you can use a network CD-ROM drive from another computer on the network. See the
Installation section for more information.

I want to use a popular 32-bit HMI program. I installed the MBX Driver and when I use the MBX
Demo program, everything works fine. However, I cannot get my HMI software to communicate
over Modbus Plus. What’s wrong?

By now, most major industrial software products are fully compatible with the MBX Driver. If the version of
your HMI product does not work with the MBX Driver, ask your HMI software manufacture for an updated
version that does.

I have several computers with version 4.01 of the MBX Driver. Recently I purchased a new SA85
adapter card that came bundled with the MBX Driver Suite CD. Can I upgrade all of my systems
with that CD?

The license agreement allows you to use this CD only on a single computer and you need to purchase
additional licenses to accommodate additional systems. However, there are subscription/upgrade
programs designed to alleviate this problem and to ensure prompt software updates to the latest revision
levels. For details of these subscription programs, contact your Schneider Automation, Inc. Modicon
brand distributor or visit Schneider Automation’s Schneider Alliances website at www.modicon.com. You
may also find additional information and white papers at Cyberlogic’s website at www.cyberlogictech.com.

http://www.modicon.com/
http://www.cyberlogictech.com/
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